<PROJECT NAME>

TEST PLAN

Version <1.0>
<dd/mm/yyyy>
VERSION HISTORY

[Provide information on how the development and distribution of the **Test Plan**, up to the final point of approval, was controlled and tracked. Use the table below to provide the version number, the author implementing the version, the date of the version, the name of the person approving the version, the date that version was approved, and a brief description of the reason for creating the revised version.]

<table>
<thead>
<tr>
<th>Version #</th>
<th>Implemented By</th>
<th>Revision Date</th>
<th>Approved By</th>
<th>Approval Date</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>&lt;Author name&gt;</td>
<td>&lt;dd/mm/yy&gt;</td>
<td>&lt;name&gt;</td>
<td>&lt;dd/mm/yy&gt;</td>
<td>Test Plan draft</td>
</tr>
</tbody>
</table>

Atlas Template Version: 01/08/17
Note to the Author

(This document is a template of a Test Plan document for a project. The template includes instructions to the author, boilerplate text, and fields that should be replaced with the values specific to the project.

- Red italicized text enclosed in square brackets ([text]) provides instructions to the document author, or describes the intent, assumptions and context for content included in this document.

- Red italicized text enclosed in angle brackets (<text>) indicates a field that should be replaced with information specific to a project.

- Text and tables in black are provided as boilerplate examples of wording and formats that may be used or modified as appropriate to a specific project. These are offered only as suggestions to assist in developing project documents; they are not mandatory formats.

When using this template for your project document, it is recommended that you follow these steps:

1. Replace all text enclosed in angle brackets (i.e., <Project Name>) with the correct field values. These angle brackets appear in both the body of the document and in headers and footers. To customize fields in Microsoft Word (which display a gray background when selected):
   a. Select File > Properties > Summary and fill in the Title field with the Document Name and the Subject field with the Project Name.
   b. Select File > Properties > Custom and fill in the Last Modified, Status, and Version fields with the appropriate information for this document.
   c. After you click OK to close the dialog box, update the fields throughout the document with these values by selecting Edit > Select All (or Command/Ctrl+A) and pressing F9. Or you can update an individual field by clicking on it and pressing F9. This must be done separately for Headers and Footers.

2. Modify boilerplate text as appropriate to the specific project.

3. To add any new sections to the document, ensure that the appropriate header and body text styles are maintained. Styles used for the Section Headings are Heading 1, Heading 2 and Heading 3. Style used for boilerplate text is Body Text.

4. To update the Table of Contents, right-click and select “Update field” and choose the option- “Update entire table”

5. Before submission of the first draft of this document, delete this “Notes to the Author” page and all instructions to the author, which appear throughout the document as red italicized text enclosed in square brackets.)
# TABLE OF CONTENTS

1 INTRODUCTION................................................................................................................................. 8  
1.1 Purpose of The Test Plan Document.................................................................................. 8  

2 COMPATIBILITY TESTING ........................................................................................................ 8  
2.1 Test Risks / Issues ........................................................................................................... 8  
2.2 Items to be Tested / Not Tested .................................................................................... 8  
2.3 Test Approach(s) .......................................................................................................... 8  
2.4 Test Regulatory / Mandate Criteria ............................................................................. 8  
2.5 Test Pass / Fail Criteria .................................................................................................... 8  
2.6 Test Entry / Exit Criteria ............................................................................................. 9  
2.7 Test Deliverables .......................................................................................................... 9  
2.8 Test Suspension / Resumption Criteria ...................................................................... 9  
2.9 Test Environmental / Staffing / Training Needs ........................................................ 9  

3 CONFORMANCE TESTING ........................................................................................................ 9  
3.1 Test Risks / Issues ........................................................................................................ 9  
3.2 Items to be Tested / Not Tested .................................................................................. 9  
3.3 Test Approach(s) ....................................................................................................... 9  
3.4 Test Regulatory / Mandate Criteria .......................................................................... 9  
3.5 Test Pass / Fail Criteria ............................................................................................ 10  
3.6 Test Entry / Exit Criteria .......................................................................................... 10  
3.7 Test Deliverables ...................................................................................................... 10  
3.8 Test Suspension / Resumption Criteria ................................................................ 10  
3.9 Test Environmental / Staffing / Training Needs ...................................................... 10  

4 FUNCTIONAL TESTING ....................................................................................................... 10  
4.1 Test Risks / Issues ................................................................................................... 10  
4.2 Items to be Tested / Not Tested ............................................................................... 10  
4.3 Test Approach(s) ..................................................................................................... 10  
4.4 Test Regulatory / Mandate Criteria ........................................................................ 11  
4.5 Test Pass / Fail Criteria .......................................................................................... 11  
4.6 Test Entry / Exit Criteria .......................................................................................... 11  
4.7 Test Deliverables ...................................................................................................... 11  
4.8 Test Suspension / Resumption Criteria .................................................................. 11  
4.9 Test Environmental / Staffing / Training Needs .................................................... 11
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>LOAD TESTING</td>
</tr>
<tr>
<td>5.1</td>
<td>Test Risks / Issues</td>
</tr>
<tr>
<td>5.2</td>
<td>Items to be Tested / Not Tested</td>
</tr>
<tr>
<td>5.3</td>
<td>Test Approach(s)</td>
</tr>
<tr>
<td>5.4</td>
<td>Test Regulatory / Mandate Criteria</td>
</tr>
<tr>
<td>5.5</td>
<td>Test Pass / Fail Criteria</td>
</tr>
<tr>
<td>5.6</td>
<td>Test Entry / Exit Criteria</td>
</tr>
<tr>
<td>5.7</td>
<td>Test Deliverables</td>
</tr>
<tr>
<td>5.8</td>
<td>Test Suspension / Resumption Criteria</td>
</tr>
<tr>
<td>5.9</td>
<td>Test Environmental / Staffing / Training Needs</td>
</tr>
<tr>
<td>6</td>
<td>PERFORMANCE TESTING</td>
</tr>
<tr>
<td>6.1</td>
<td>Test Risks / Issues</td>
</tr>
<tr>
<td>6.2</td>
<td>Items to be Tested / Not Tested</td>
</tr>
<tr>
<td>6.3</td>
<td>Test Approach(s)</td>
</tr>
<tr>
<td>6.4</td>
<td>Test Regulatory / Mandate Criteria</td>
</tr>
<tr>
<td>6.5</td>
<td>Test Pass / Fail Criteria</td>
</tr>
<tr>
<td>6.6</td>
<td>Test Entry / Exit Criteria</td>
</tr>
<tr>
<td>6.7</td>
<td>Test Deliverables</td>
</tr>
<tr>
<td>6.8</td>
<td>Test Suspension / Resumption Criteria</td>
</tr>
<tr>
<td>6.9</td>
<td>Test Environmental / Staffing / Training Needs</td>
</tr>
<tr>
<td>7</td>
<td>REGRESSION TESTING</td>
</tr>
<tr>
<td>7.1</td>
<td>Test Risks / Issues</td>
</tr>
<tr>
<td>7.2</td>
<td>Items to be Tested / Not Tested</td>
</tr>
<tr>
<td>7.3</td>
<td>Test Approach(s)</td>
</tr>
<tr>
<td>7.4</td>
<td>Test Regulatory / Mandate Criteria</td>
</tr>
<tr>
<td>7.5</td>
<td>Test Pass / Fail Criteria</td>
</tr>
<tr>
<td>7.6</td>
<td>Test Entry / Exit Criteria</td>
</tr>
<tr>
<td>7.7</td>
<td>Test Deliverables</td>
</tr>
<tr>
<td>7.8</td>
<td>Test Suspension / Resumption Criteria</td>
</tr>
<tr>
<td>7.9</td>
<td>Test Environmental / Staffing / Training Needs</td>
</tr>
<tr>
<td>8</td>
<td>STRESS TESTING</td>
</tr>
<tr>
<td>8.1</td>
<td>Test Risks / Issues</td>
</tr>
<tr>
<td>8.2</td>
<td>Items to be Tested / Not Tested</td>
</tr>
<tr>
<td>8.3</td>
<td>Test Approach(s)</td>
</tr>
<tr>
<td>8.4</td>
<td>Test Regulatory / Mandate Criteria</td>
</tr>
<tr>
<td>8.5</td>
<td>Test Pass / Fail Criteria</td>
</tr>
</tbody>
</table>
8.6 Test Entry / Exit Criteria ........................................................................................................ 15
8.7 Test Deliverables .................................................................................................................. 15
8.8 Test Suspension / Resumption Criteria .............................................................................. 15
8.9 Test Environmental / Staffing / Training Needs ................................................................. 15

9 SYSTEM TESTING .................................................................................................................. 15
9.1 Test Risks / Issues ................................................................................................................ 15
9.2 Items to be Tested / Not Tested .......................................................................................... 15
9.3 Test Approach(s) .................................................................................................................. 16
9.4 Test Regulatory / Mandate Criteria .................................................................................... 16
9.5 Test Pass / Fail Criteria ....................................................................................................... 16
9.6 Test Entry / Exit Criteria ..................................................................................................... 16
9.7 Test Deliverables .................................................................................................................. 16
9.8 Test Suspension / Resumption Criteria .............................................................................. 16
9.9 Test Environmental / Staffing / Training Needs ................................................................. 16

10 UNIT TESTING ..................................................................................................................... 16
10.1 Test Risks / Issues ............................................................................................................... 16
10.2 Items to be Tested / Not Tested .......................................................................................... 16
10.3 Test Approach(s) ................................................................................................................ 17
10.4 Test Regulatory / Mandate Criteria .................................................................................... 17
10.5 Test Pass / Fail Criteria ....................................................................................................... 17
10.6 Test Entry / Exit Criteria ..................................................................................................... 17
10.7 Test Deliverables .................................................................................................................. 17
10.8 Test Suspension / Resumption Criteria .............................................................................. 17
10.9 Test Environmental / Staffing / Training Needs ................................................................. 17

11 USER ACCEPTANCE TESTING ............................................................................................ 17
11.1 Test Risks / Issues ............................................................................................................... 17
11.2 Items to be Tested / Not Tested .......................................................................................... 17
11.3 Test Approach(s) ................................................................................................................ 18
11.4 Test Regulatory / Mandate Criteria .................................................................................... 18
11.5 Test Pass / Fail Criteria ....................................................................................................... 18
11.6 Test Entry / Exit Criteria ..................................................................................................... 18
11.7 Test Deliverables .................................................................................................................. 18
11.8 Test Suspension / Resumption Criteria .............................................................................. 18
11.9 Test Environmental / Staffing / Training Needs ................................................................. 18

TEST PLAN APPROVAL ............................................................................................................ 19
APPENDIX A: REFERENCES ................................................................................................... 20
APPENDIX B: KEY TERMS ..................................................................................................... 21
1 INTRODUCTION

1.1 PURPOSE OF THE TEST PLAN DOCUMENT

[Provide the purpose of the Test Plan Document. This document should be tailored to fit a project’s needs.]
This Test Plan document documents and tracks the necessary information required to effectively define the approach to be used in the testing of the project’s product. The Test Plan document is created during the Planning Phase of the project. Its intended audience is the Project Manager, Software Development Team, and the Software Testing Team. Some portions of this document may on occasion be shared with the customer/user and other stakeholders whose input/approval into the testing process is needed.

2 COMPATIBILITY TESTING

2.1 TEST RISKS / ISSUES

[Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]

2.2 ITEMS TO BE TESTED / NOT TESTED

[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]

<table>
<thead>
<tr>
<th>Item to Test</th>
<th>Test Description</th>
<th>Test Date</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2.3 TEST APPROACH(S)

[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]

2.4 TEST REGULATORY / MANDATE CRITERIA

[Describe any regulations or mandates that the system must be tested against.]

2.5 TEST PASS / FAIL CRITERIA

[Describe the criteria used to determine if a test item has passed or failed its test.]
2.6 TEST ENTRY / EXIT CRITERIA

[Describe the entry and exit criteria used to start testing and determine when to stop testing.]

2.7 TEST DELIVERABLES

[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]

2.8 TEST SUSPENSION / RESUMPTION CRITERIA

[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]

2.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS

[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc.).]

3 CONFORMANCE TESTING

3.1 TEST RISKS / ISSUES

[Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]

3.2 ITEMS TO BE TESTED / NOT TESTED

[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]

<table>
<thead>
<tr>
<th>Item to Test</th>
<th>Test Description</th>
<th>Test Date</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3.3 TEST APPROACH(S)

[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]

3.4 TEST REGULATORY / MANDATE CRITERIA

[Describe any regulations or mandates that the system must be tested against.]
3.5 TEST PASS / FAIL CRITERIA

[Describe the criteria used to determine if a test item has passed or failed its test.]

3.6 TEST ENTRY / EXIT CRITERIA

[Describe the entry and exit criteria used to start testing and determine when to stop testing.]

3.7 TEST DELIVERABLES

[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]

3.8 TEST SUSPENSION / RESUMPTION CRITERIA

[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]

3.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS

[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc.).]

4 FUNCTIONAL TESTING

4.1 TEST RISKS / ISSUES

[Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]

4.2 ITEMS TO BE TESTED / NOT TESTED

[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]

<table>
<thead>
<tr>
<th>Item to Test</th>
<th>Test Description</th>
<th>Test Date</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4.3 TEST APPROACH(S)

[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]
4.4 TEST REGULATORY / MANDATE CRITERIA
[Describe any regulations or mandates that the system must be tested against.]

4.5 TEST PASS / FAIL CRITERIA
[Describe the criteria used to determine if a test item has passed or failed its test.]

4.6 TEST ENTRY / EXIT CRITERIA
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]

4.7 TEST DELIVERABLES
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]

4.8 TEST SUSPENSION / RESUMPTION CRITERIA
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]

4.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc.).]

5 LOAD TESTING

5.1 TEST RISKS / ISSUES
[Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]

5.2 ITEMS TO BE TESTED / NOT TESTED
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]

<table>
<thead>
<tr>
<th>Item to Test</th>
<th>Test Description</th>
<th>Test Date</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5.3 TEST APPROACH(S)

[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]

5.4 TEST REGULATORY / MANDATE CRITERIA

[Describe any regulations or mandates that the system must be tested against.]

5.5 TEST PASS / FAIL CRITERIA

[Describe the criteria used to determine if a test item has passed or failed its test.]

5.6 TEST ENTRY / EXIT CRITERIA

[Describe the entry and exit criteria used to start testing and determine when to stop testing.]

5.7 TEST DELIVERABLES

[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]

5.8 TEST SUSPENSION / RESUMPTION CRITERIA

[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]

5.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS

[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc.).]

6 PERFORMANCE TESTING

6.1 TEST RISKS / ISSUES

[Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]

6.2 ITEMS TO BE TESTED / NOT TESTED

[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]

<table>
<thead>
<tr>
<th>Item to Test</th>
<th>Test Description</th>
<th>Test Date</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6.3 TEST APPROACH(S)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]

6.4 TEST REGULATORY / MANDATE CRITERIA
[Describe any regulations or mandates that the system must be tested against.]

6.5 TEST PASS / FAIL CRITERIA
[Describe the criteria used to determine if a test item has passed or failed its test.]

6.6 TEST ENTRY / EXIT CRITERIA
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]

6.7 TEST DELIVERABLES
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]

6.8 TEST SUSPENSION / RESUMPTION CRITERIA
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]

6.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc.).]

7 REGRESSION TESTING

7.1 TEST RISKS / ISSUES
[Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]

7.2 ITEMS TO BE TESTED / NOT TESTED
[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]

<table>
<thead>
<tr>
<th>Item to Test</th>
<th>Test Description</th>
<th>Test Date</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[Insert appropriate disclaimer(s)]
7.3 TEST APPROACH(S)

[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]

7.4 TEST REGULATORY / MANDATE CRITERIA

[Describe any regulations or mandates that the system must be tested against.]

7.5 TEST PASS / FAIL CRITERIA

[Describe the criteria used to determine if a test item has passed or failed its test.]

7.6 TEST ENTRY / EXIT CRITERIA

[Describe the entry and exit criteria used to start testing and determine when to stop testing.]

7.7 TEST DELIVERABLES

[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]

7.8 TEST SUSPENSION / RESUMPTION CRITERIA

[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]

7.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS

[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc.).]

8 STRESS TESTING

8.1 TEST RISKS / ISSUES

[Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]

8.2 ITEMS TO BE TESTED / NOT TESTED

[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]

<table>
<thead>
<tr>
<th>Item to Test</th>
<th>Test Description</th>
<th>Test Date</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[Insert appropriate disclaimer(s)]
8.3 TEST APPROACH(S)

[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]

8.4 TEST REGULATORY / MANDATE CRITERIA

[Describe any regulations or mandates that the system must be tested against.]

8.5 TEST PASS / FAIL CRITERIA

[Describe the criteria used to determine if a test item has passed or failed its test.]

8.6 TEST ENTRY / EXIT CRITERIA

[Describe the entry and exit criteria used to start testing and determine when to stop testing.]

8.7 TEST DELIVERABLES

[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]

8.8 TEST SUSPENSION / RESUMPTION CRITERIA

[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]

8.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS

[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc.).]

9 SYSTEM TESTING

9.1 TEST RISKS / ISSUES

[Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]

9.2 ITEMS TO BE TESTED / NOT TESTED

[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]

<table>
<thead>
<tr>
<th>Item to Test</th>
<th>Test Description</th>
<th>Test Date</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
9.3 TEST APPROACH(S)

[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]

9.4 TEST REGULATORY / MANDATE CRITERIA

[Describe any regulations or mandates that the system must be tested against.]

9.5 TEST PASS / FAIL CRITERIA

[Describe the criteria used to determine if a test item has passed or failed its test.]

9.6 TEST ENTRY / EXIT CRITERIA

[Describe the entry and exit criteria used to start testing and determine when to stop testing.]

9.7 TEST DELIVERABLES

[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]

9.8 TEST SUSPENSION / RESUMPTION CRITERIA

[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]

9.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS

[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc.).]

10 UNIT TESTING

10.1 TEST RISKS / ISSUES

[Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]

10.2 ITEMS TO BE TESTED / NOT TESTED

[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]

<table>
<thead>
<tr>
<th>Item to Test</th>
<th>Test Description</th>
<th>Test Date</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
10.3 TEST APPROACH(S)

[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]

10.4 TEST REGULATORY / MANDATE CRITERIA

[Describe any regulations or mandates that the system must be tested against.]

10.5 TEST PASS / FAIL CRITERIA

[Describe the criteria used to determine if a test item has passed or failed its test.]

10.6 TEST ENTRY / EXIT CRITERIA

[Describe the entry and exit criteria used to start testing and determine when to stop testing.]

10.7 TEST DELIVERABLES

[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]

10.8 TEST SUSPENSION / RESUMPTION CRITERIA

[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]

10.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS

[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc.).]

11 USER ACCEPTANCE TESTING

11.1 TEST RISKS / ISSUES

[Describe the risks associated with product testing or provide a reference to a document location where it is stored. Also outline appropriate mitigation strategies and contingency plans.]

11.2 ITEMS TO BE TESTED / NOT TESTED

[Describe the items/features/functions to be tested that are within the scope of this test plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items agreed not to be tested.]

<table>
<thead>
<tr>
<th>Item to Test</th>
<th>Test Description</th>
<th>Test Date</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
11.3 TEST APPROACH(S)
[Describe the overall testing approach to be used to test the project’s product. Provide an outline of any planned tests.]

11.4 TEST REGULATORY / MANDATE CRITERIA
[Describe any regulations or mandates that the system must be tested against.]

11.5 TEST PASS / FAIL CRITERIA
[Describe the criteria used to determine if a test item has passed or failed its test.]

11.6 TEST ENTRY / EXIT CRITERIA
[Describe the entry and exit criteria used to start testing and determine when to stop testing.]

11.7 TEST DELIVERABLES
[Describe the deliverables that will result from the testing process (documents, reports, charts, etc.).]

11.8 TEST SUSPENSION / RESUMPTION CRITERIA
[Describe the suspension criteria that may be used to suspend all or portions of testing. Also describe the resumption criteria that may be used to resume testing.]

11.9 TEST ENVIRONMENTAL / STAFFING / TRAINING NEEDS
[Describe any specific requirements needed for the testing to be performed (hardware/software, staffing, skills training, etc.).]
TEST PLAN APPROVAL

The undersigned acknowledge they have reviewed the <Project Name> Test Plan document and agree with the approach it presents. Any changes to this Requirements Definition will be coordinated with and approved by the undersigned or their designated representatives.

[List the individuals whose signatures are required. Examples of such individuals are Business Analyst, Technical Manager, and Project Manager. Add additional signature lines as necessary.]

Signature: ___________________________  Date: _______________
Print Name: ___________________________
Title: _________________________________
Role: _________________________________

Signature: ___________________________  Date: _______________
Print Name: ___________________________
Title: _________________________________
Role: _________________________________

Signature: ___________________________  Date: _______________
Print Name: ___________________________
Title: _________________________________
Role: _________________________________

Signature: ___________________________  Date: _______________
Print Name: ___________________________
Title: _________________________________
Role: _________________________________

[Insert appropriate disclaimer(s)]
Appendix A: References

[Insert the name, version number, description, and physical location of any documents referenced in this document. Add rows to the table as necessary.]

The following table summarizes the documents referenced in this document.

<table>
<thead>
<tr>
<th>Document Name and Version</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Document Name and Version Number&gt;</td>
<td>[Provide description of the document]</td>
<td>&lt;URL or Network path where document is located&gt;</td>
</tr>
</tbody>
</table>
Appendix B: Key Terms

[Insert terms and definitions used in this document. Add rows to the table as necessary.]

The following table provides definitions for terms relevant to this document.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Insert Term]</td>
<td>[Provide definition of the term used in this document.]</td>
</tr>
<tr>
<td>[Insert Term]</td>
<td>[Provide definition of the term used in this document.]</td>
</tr>
<tr>
<td>[Insert Term]</td>
<td>[Provide definition of the term used in this document.]</td>
</tr>
</tbody>
</table>